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Pix4Dmapper Exercise 1: Image
Processing for UAS Imagery

Introduction

Pix4Dmapper is a photogrammetry software suite compatible with UAS (unmanned aircraft system)
imagery that enables you to define areas of interest, select processing options, add ground control
points (GCPs), and create and edit point clouds, digital surface models (DSMs), meshes, and
orthomosaics. Default templates provide automatic processing for new projects and can be customized
for more control over data and output product quality.

This exercise will introduce you to the general workflow for processing UAS imagery in Pix4Dmapper.
Please see exercise 2 for a more in-depth look at some of the settings and tools found in Pix4Dmapper.
As you work through this exercise, please refer to the Pix4Dmapper Help Documentation for additional
information about each of the steps. The help documentation can be found on the Pix4D website or by
clicking the Help tab within the software interface.

Objective
o Become familiar with the user interface and features found within Pix4Dmapper.
e Learn how to georeference imagery and create a dense point cloud, a 3D textured mesh, a
digital surface model (DSM) and an orthomosaic with Pix4Dmapper.

Prerequisites
o Download and unzip exercise data of the embankment and spillway at Tony Grove Lake in
northern Utah: TonyGrove_subset 20191015.zip
e Download exercise data Ex1_TonyGrove_GCPs.txt (optional)
e Review the Appendix located at the end of this document
e Install and activate Pix4Dmapper (please see Pix4Dmapper Installation Guide for details)

NOTE: If you experience cursor misalignment throughout this exercise, open your File Explorer and
navigate to your Program Files folder on the Drive you installed Pix4Dmapper. Right click on the
pixddmapper.exe file and in the Properties window, select the Compatibility tab. Enable Disable display
scaling on high DPI settings and click OK. You may need to close and reopen Pix4Dmapper for the cursor
to be recalibrated.
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Part 1: Getting Started

In this first part of the exercise, you will navigate the project creation wizard, which consists of five
windows, to configure important settings and options for your Pix4Dmapper project. This section will
acquaint you with folder directories where the project outputs will be stored, where you can manage
the camera model’s parameters, select coordinate systems, and select your processing options
template.

A. Create a Project
1. Launch Pix4Dmapper by searching Pix4Dmapper in the Start menu bar and click New Project.

2. Name the project TonyGrove and set your file directory. Make sure the radio button for New
Project is selected and click Next.

NOTE: Structured subfolders will be generated within your project folder along with your LOG file, which
you can use to review your settings and accuracy once your project is finished. You can locate your
generated reports in 1_initial, your point clouds in 2_densification, and your digital surface model and
orthomosaic in 3_dsm_ortho.

Marne
1_initial
| 2_densification
3_d=m_ortho
temp

If you leave the file directory as the default pathway, your project folder will be created at This PC,
Documents, Pix4D. If you want to save the project folder elsewhere, you can specify a desired directory
upon creating a new project. After you finish processing, you can go to this folder to access the products
and to import them into other GIS software, such as ArcGIS Pro, for further investigation and use.

B. Add the imagery

1. In the Select Images window, click on Add Images and browse to the unzipped folder for
TonyGrove_subset 20191015 in which the imagery is stored. Select all 105 images and click
Open, then Next. It may take a moment for Pix4Dmapper to read the geotag data.

2. Leave the following parameters as their default values:
i. Datum: WGS 1984; Coordinate System: WGS 84 (EGM 96 Geoid)
ii. Geolocation Accuracy: Standard
iii. Selected Camera Model: FC6310_8.8_5472x3648 (RGB)
3. Click Next.
4. In the Select Output Coordinate System window:
i. Ensure that the Unit is specified as meters (m).
ii. Leave the following parameters as their default values:
(a) Autodetected: WGS 84 / UTM zone 12N
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(b) Advanced Coordinate Options: unchecked.

NOTE: You can check Advanced Coordinate Options to further explore and set alternative output and
vertical coordinate systems for adjusting the geoid height but for this exercise, we recommend using the
default settings.

5. Click Next.

C. Select Template

1. Under Processing Options Template, navigate to the Rapid tab, then select 3D Maps -
Rapid/Low Res.

2. Uncheck Start Processing Now since we'll explore our processing options before we start
aligning the images.

3. Click Finish to finalize the initial project setup.

NOTE: Depending on what outputs your project requires and what imagery you are loading, you can opt
for different templates. For producing Point Clouds, DSMs, 3D Meshes and Orthomosaics from aerial
imagery, you will select either Standard or Rapid 3D Maps. Rapid will produce lower quality results more
quickly so we will use rapid for this exercise. These options are also good for measuring volumes,
digitizing houses and roads, and generating contour lines. For producing Point Clouds and 3D Meshes
from ground-based imagery, you will select either Standard or Rapid 3D Models. This option is good for
3D models of buildings, statues, and other objects. If you opt to use Standard processing for larger image
files, you may want to consider running the process overnight.

D. Exploring the Main Viewer
When you have completed your initial project setup, Pix4Dmapper will open in Map View. Map view
consists of the following main components, color coded to match the following figure:

ok W M

WGS54 - (41.89380194, -111.63862698) WGS84 / UTM zome 12N - { 447022462, 4638182.442) [m]
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. Red: Menu bar

Here you can find five menu bar items: Project, Process, View, rayCloud and Help. Depending
on which tab you select, you can open, save, and create new projects, define properties of
images and ground control points (GCPs), change your output coordinate system, update
processing options, change which View Toolbar items are displayed, change navigation modes
depending and access online support and community forums.

. Orange: Toolbar

Depending on the status of the project and which options have been selected, some buttons
within the Toolbar may be grayed out. These tools are divided into six subcategories: Project,
Process, View, Navigation, Clipping and Point Cloud Editing. From these options, you can
update image geolocation and camera model information, select, or change your coordinate
system, import, edit, add, or remove ground control points, force open the Quality Report,
reoptimize your outputs, change how you view your data and edit and correct your point
cloud if errors occur (e.g., reclassification). On the far right of the Toolbar you can access the
login information, manage licenses and privacy preferences as well as access the shortcut
button for turning on and off the Sidebar.

. Yellow: Home Tab, View Toolbar

Home takes you back to your Welcome View window where you can select to generate a new
project, open an existing project or access community forums and tips.

. Light green: Map View Tab, View Toolbar

Map View will display a 2D map version of your project with a satellite imagery background
when images are geotagged.

. Dark green: rayCloud Tab, View Toolbar

The rayCloud tab is where you can visualize different elements such as cameras, GCPs, dense
point cloud output, classification of cloud points and a textured 3D mesh. Here, you can also
georeference your project, improve accuracy, create orthoplanes and other objects, measure
distances and surfaces and export your point cloud files. Volumes enables you to draw and
visualize volumes, measure them and import or export them also.

. Purple: Mosaic Editor Tab, View Toolbar

When Mosaic Editor is selected, you can visualize the DSM, DTM and mosaic, as well as
improve the visual aspect of the orthomosaic.

. Brown: processing Menu

Under the Processing Menu, Processing Options generates a pop-up window where you can
edit your parameters for each of the individual steps: Initial Processing, Point Cloud and mesh
and DSM, Orthomosaic and Index.

. Black: Processing View

The Current bar shows the processing status of each sub-step is displayed as a percentage,
and the Total bar will show the processing status of all steps that have been selected as the
number of completed steps. Before hitting the Start button to run the process, each step can
be checked as to whether the user wants to run the three-step process as a batch, or section
by section. To stop the processing part way through, the user can hit the Cancel button.
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Part 2: Image Alignment and Calibration

After loading the images and setting up the project file, Pix4Dmapper gives you the option to run Initial
Processing. In this step, Pix4Dmapper aligns the images to one another using Structure from Motion
(SfM) algorithms. The first part of this is that it finds thousands of contrasting features in each image,
which are saved as key points. It then compares key-point patterns between images to identify and
create automatic tie points (ATPs). Once the ATPs are identified, the software uses aerial triangulation
to estimate the camera-calibration parameters and to refine the image coordinates. location of the
images. Doing so improves the accuracy of the 3D model and products.

NOTE: In this exercise, the images you use are already georeferenced, enabling you to immediately start
processing. In the case where your images may not be georeferenced, refer to the Appendix to learn how
to place initial Ground Control Points (GCPs) using your Ex1_TonyGrove_GCPs.txt file and the Basic
Editor tool and rayCloud. This is an optional step that you can practice when you have sufficient time.

A. Image Alignment and Calibration

1. If you cannot see the Processing menu at the bottom left of the screen, navigate to and click
on the View tab in the main menu and then click Processing.

2. In the Processing menu at the bottom left of the main window, confirm that Step 1 - Initial
Procesing, Step 2 - Point Cloud and Mesh, and Step 3 - DSM, Orthomosaic, and Index are red.
Ensure that Step 1 is checked, and uncheck Step 2 and Step 3, then click Start. Depending on
your computer’s technical specifications, this can take a few minutes to run.

3. Review the generated Quality Report to ensure that your data passes the Quality Checks
listed at the beginning of the document.This will automatically export as a PDF to your project
folder and update each time you run a new step.

NOTE: Your Quality Report will also offer insight into Calibration Details where you check if all cameras
have calibrated correctly in addition to the overlap the images possess and the uncertainties between
the initial GCP placements versus their computed placements. By using further georeferencing tools
later, we will try to improve both the meter and pixel accuracy as specified in the Ground Control Points

Table on page 7.

4. If not already selected, select the rayCloud tab on the left hand side of the software interface
and navigate around the cameras and ATP cloud in the main window. Left click and hold to
pan around and zoom into the point cloud as you move your mouse or finger on your
trackpad, and hit shift in addition to rotate the point cloud.

5. Monitor the processing status bar at the bottom of the Pix4Dmapper interface. After it
completes the Initial Processing, go ahead and save your project (Project, Save).

Part 3: Creating a Dense Point Cloud and Orthomosaic

By running Step 2 - Point Cloud and Mesh, Pix4Dmapper’s image processing algorithms can create a
dense point cloud by using the ATPs as a starting point. The total number of points, usually in the
thousands to millions, depends on several factors, including but not limited to, image overlap, image
content, and settings specified. The dense point cloud will provide a 3D representation of your study
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area and enable the generation of a textured mesh and DSM. In Step 3 - DSM, Orthomosaic and Index,
you will use the DSM as the input to generate the orthomosaic output.

A. Generating a Dense Point Cloud

1. Click on Processing Options in the bottom left-hand corner of the main window. Under the
Point Cloud and Mesh section, locate the Point Cloud tab at the top. Under the Point Cloud
Classification section, check Classify Point Cloud.

2. Click OK to close Processing Options.

3. In the Processing menu at the bottom left of the screen, confirm that Step 1 - Initial
Processing is green and that Step 2 - Point Cloud and Mesh, and Step 3 - DSM, Orthomosaic,
and Index are red. Make sure you uncheck Step 1 so as to not overwrite what you have
already created, check Step 2 and make sure Step 3 is unchecked. Then click Start. Expect for
this to take several minutes to run.

4. Close your generated report, then navigate to Layers on the left-hand side of the screen and
uncheck Cameras and Tie Points.

5. Under Layers, check Point Clouds and click OK in response to the warning message as shown
below. Navigate around your dense point cloud.

Layer
"TonyGrove_group1_densified_point_cloud”
is not loaded. Do you want to load it now?

[[] Don't Display This Message Again.

[oc ] concel |

NOTE: To tilt view your dense point and mesh, hold shift as you left click on your mouse or trackpad and
move in the direction you would like to view the generated products from. Use the scroll wheel to zoom
in and out. Left click to move horizontally. Click and hold the scroll wheel to orbit. To view all points
within your dense point cloud, hit the View All button on the View toolbar.

KA
(ST

View

6. Under Project, click Save.

B. Generating an Orthomosaic

1. In the Processing menu, ensure that Step 1 - Initial Processing is still unchecked, uncheck Step
2 - Point Cloud and Mesh and check Step 3 - DSM, Orthomosaic, and Index. Click Start.This
may take several minutes to run.

2. Note how the newly generated Quality Report resembles the previous one with additional
information about your orthomosaic. Click Close.

3. On the left-hand side panel, click on Mosaic Editor.

4. In the main menu at the top of the software interface, click Mosaic Editor, then View
followed by Show DSM to view your DSM and navigate around the output using the same
methods to zoom, pan and tilt as described in Part 3.
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5. In the main toolbar, click on the Display Mosaic dropdown and select Mosaic (group 1) to view
and explore the orthomosaic output.

Project Process View Mosaic Editor Help

d @9 pédceaaim I
Project Process View Edit Mosaic

6. In the Mosaic Editing menu on the right-hand side, click the Export button to have the output
saved to your project folder pathway (see following figure). If you encounter a warning
message about exporting your orthomosaic, click OK.

¥ Export

| ssve || Rest | Bpot || Hep

7. Under Project, click Save.

NOTE: Sometimes distortions may occur in an orthomosaic due to errors in the surface model and
features not fully visible in overlapping images, especially if there is a lot of tall vegetation. You may wish
to generate new products using different settings or edit your existing one. If there are relatively low
number of distortions, you can use the Mosaic Editor to improve your outputs, see Pix4Dmapper Exercise
2: Additional Steps for Processing UAS Imagery, otherwise, consider rerunning Step 3 after making
changes to the project’s parameters by exploring the settings for each step under Processing Options.

Conclusion: Congratulations! You have completed this first Pix4Dmapper exercise for
processing UAS Imagery! In this exercise, we learned how to use Pix4Dmapper to align images,
add GCPs for georeferencing purposes and create a dense point cloud and orthomosaic.
Additional resources, including a few tutorials and a very helpful user forum, can be found on
the Pix4D website.
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Appendix A: Ground Control Points (GCPs)

GCPs are crucial for geospatially positioning and scaling the imagery. Point coordinates are generally

obtained with a GPS unit in the field or by using a reference image (as was done for this exercise). When
images are not georeferenced, each GCP needs to be located and added to each image it intercepts. The
graphic below shows marker locations corresponding to the Ex1_TonyGrove_GCPs.txt file.
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Refer to the following zoomed-in images to know where to place markers. Since the scale and
placement depends upon these markers, it is important to place them as accurately as possible.
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Service Geospatial Technology and Applications Center | Pix4Dmapper: Exercise 1 | 9




USDA
el

United States Department of Agriculture

Adding GCPs

This optional part of the exercise would be performed after setting up your project, and prior to Part 2:
Image Alignment and Calibration.

UAS images typically contain geotagged coordinates (embedded in the files) to georeference the
outputs. For some projects, these geotagged coordinates, which are usually accurate to within 2 meters
horizontal accuracy, are all that are needed to create the outputs. However, if the images lack
geotagged coordinates or if you wish to improve the accuracy of the products, Pix4Dmapper has tools to
place GCPs on the images. Ground coordinates for GCPs generally come from another reference image
or by collecting the information in the field with a GPS unit. The latter method generally produces the
most accurate results but is also the more expensive and labor intensive of the two. Since this exercise
consists of a subset of the original collection, the GCPs provided to you in this exercise were created
using a combination of both methods.

A minimum of three GCPs are needed to georeference the model. For better results, it is recommended
to distribute five to ten GCPs throughout the model. GCPs can be added either before or after the
images are aligned. In most cases, it is easiest to add them after image alignment. However, to give you
experience with both approaches, we’ll explain how to place three of the six GCPs before image
alignment, and then place the remaining three using a different tool after the images are aligned.

A. Adding Ground Control Points
1. Under Project in the main window, click GCP/MTP Manager.
2. Click Import GCPs.

3. For Coordinates Order, select X, Y, Z then Browse and locate the Excel spreadsheet with the
GCP coordinates in the course downloads folder titled Ex1_TonyGrove_GCPs.txt. Click Open
and OK.

4. Click Basic Editor.

NOTE: The basic editor is used before processing the imagery. To add GCPs after processing you should
use the rayCloud editor, which you will do with the remaining three GCPs later in this exercise.

GCPs can be manually created using reference imagery and a digital elevation model (DEM). However,
keep in mind that your products will only be as accurate as the reference data. In this exercise, GCP
coordinates are provided, but tools like ArcGIS Pro or Google Earth can be used for displaying reference
data and for obtaining the needed GCP coordinates. To create your own GCPs, you’ll need to locate
unchanged features (rocks, road intersections, trails) that are clearly visible in both the UAS imagery and
the reference imagery. You would then make note of the longitude, latitude, and elevation (x, y, z) values
of those features, as found in the reference data viewer (ArcMap or Google Earth). This information can
then be added into the GCP/MTP Table located in the GCP/Manager window.

5. Review the images shown at the beginning of this Appendix) to see the locations of each GCP.
6. Click on the first GCP in the GCP/MTP Table.
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& Basic GCP/MTP Editor x

GCP/MTP Table (WGS 84 /UTM zone 12N (EGM 96 Geaid))

s i m m) m Horz Vert i
11 3D GCP A46T38.265 4638140.669 2457706 0.020 020
[ Point is not marked on enough images. | 445806.475 4638134.552 2453880 0.020 0.020
03 30 GCP 446780183 4638100.830 2455.997 0.020 0.020
04 30 GCP H46T27.796 4638083.618 2452458 0.020 0020
05 3D GCP 446825.231 4638054.655 2451.247 0.020 0020
06 3D GCP 46758277 4632017.611 2456.145 0.020 0.020

Images
.. -
DIL0243JPG ~ €l 7 15
DII_0244.1PG L
DJI_0242JPG =
DI_0193.JPG
DII_0270JPG @
DII_D1S2IPG ]
DIL_D194PG = -
DI02T1IPG
DJI_0269.PG -_-
DII_0241JPG
DII_0195.PG
DI_0272JPG
DII_0165.PG
DII_0166.PG
DII_0164.PG =
DJI 0240.PG ¥ ]
GCPMTP Manager o] conce reb

7. Mark the target on at least ten of the corresponding photographs DJI_; 0243.JPG, 0244.JPG,
0242.JPG, 0193.JPG, 0270.JPG, 0192.JPG, 0194.JPG, 0271.JPG, 0269.JPG, 0241.JPG, 0165.JPG,
0166.JPG, 0164.JPG, 0319.JPG, 0320.JPG and 0318.JPG. Do this by sorting your images in
numerical order using the sort button. Then double click on the image name in the bottom
left panel and using the controls on the right, zoom in and place the GCP on the thumbnail
image. Be cautious when placing your markers; some images may include more than one
marker and it is important to select the correct one to avoid having to restart the process.
Once completed, check that the number displayed next to the first GCP in the table reads 16.
This is the number of images in which you have placed the corresponding GCP.

NOTE: It is important to note that all images in this sample dataset are oriented with north being up,
which makes it easier to place the GCPs. This won’t always be the case since some flight plans have the
UAS rotate 180° at the end of each flight line and/or may fly east and west flight lines. Therefore, with
other datasets, you may notice that some of the images are rotated as you are placing your GCPs.

8. Do the same for the second and third marker.

i. For the second marker, you will locate the GCP in ten of the following photographs DJI_;
346.JPG, 345.JPG, 347.JPG, 318.JPG, 317.JPG, 344.JPG, 319.JPG, 320.JPG, 272.JPG,
271.JPG, 273.JPG, 270.JPG and 269.JPG.

ii. For the third marker, you can locate the GCP in any of the ten following photographs DJI_;
275.JPG, 274.JPG, 239.JPG, 238.JPG, 276.JPG, 273.JPG, 240.JPG, 315.JPG, 314.JPG,
316.JPG, 237.JPG, 272.JPG, 241.JPG, 313.JPG, 317.JPG, 197.JPG, 198.JPG, 196.JPG,
349.JPG, 195.JPG, 350.JPG, 346.JPG and 347.JPG.

NOTE: To zoom in on the thumbnail image to place a GCP, you can pinch zoom using your computer’s
trackpad, use the scroll wheel on your mouse, or drag the pointer on the scale bar to the left with
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magnifying glasses. To pan around the image, you can either left click and hold on your mouse and drag
the image to the area you want to view, or you can use the arrows above the scale bar on the right. To
reset the image to its original state, click the button located in the middle of the four arrows used for
panning.

9. Once the first three GCPs have been placed on their respective images, click OK.
10. Under Project in the main window, click Save Project.

Further Georeferencing and Reoptimizing

This optional part of the exercise would be performed only if you have manually added the first three
GCPs from the Adding GCPs section of the Appendix. Complete Part 2: Image Alignment and
Calibration, then you can proceed with the following steps.

The main advantage of the rayCloud is that it automatically estimates which images GCPs fall on since
the images have already been aligned. This makes placing GCPs with the RayCloud much faster than
using the Basic Editor tool which is referenced in the Appendix. It is best to place GCPs on all images
where you can clearly see where the GCP should be placed. After you finish adding the six GCPs, you will
reoptimize the camera calibration to improve the overall model accuracy.

A. Georeferencing with rayCloud
1. Under the View tab in the main menu, ensure rayCloud and Show Sidebar are turned on.

2. Under Layers on the left-hand side, click the drop-down bar next to Cameras, and do the
same again for Display Properties.

3. Under Display Properties, locate the line for Position Error and uncheck the box.
4. Drag the edge of the sidebar, located on the right, towards the left of the screen so that it fills
most of the window.

5. In the Layers list on the left-hand side, click the drop-down bar next to Tie Points if it is not
already expanded, and do the same again for GCPs/MTPs and again for Display Properties.

6. Click on the fourth GCP listed. Collapse the Selection section in the sidebar to close the image
details and drag the Image Size slider to increase image thumbnail sizes.

NOTE: As in Part 2, you can place your cursor on each image and zoom in and out using your trackpad or
mouse scroll wheel. To pan the image, left click and drag. If necessary, hold your cursor over an image
and tap the spacebar for it to fill your screen if you need to see it at a larger scale. Tap the spacebar
again to return the image to its original size within the side panel.
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7. Review the images shown in the earlier section of this Appendix to find the target for the
fourth GCP. Try to locate the GCP in image DJI_0121.JPG, displayed in the sidebar. Take note
that by placing the first three GCPs and running the initial processing step, the images
containing the GCP have been autogenerated and it will now be quicker to place the
remaining ones. Click the center of the target. Click Delete or drag and drop to reposition the
GCP if it is incorrectly placed. If you notice something looking odd in this step, revisit the
Adding GCPs part of this Appendix to ensure all previous markers were correctly placed.

8. Confirm the location of the same GCP in image, DJI_0122.JPG. The yellow circle that appears
around the GCP confirms that it has been marked successfully.

9. Click Selection to expand the GCP’s details and then click Apply. Collapse the Selection
section once again. This will automatically place the GCP on the remaining images for you.

10. Drag the Zoom Level slider to the right until you can see the target for the GCP clearly in the
remaining images. Click on the green crosses to confirm the location of it in each additional
image.

11. Expand the Selection section once again and hit Apply. If more images appear, continue
through the process of confirming the GCP location and clicking Apply until no more new
images appear.

12. Follow steps 6. through 12. for the remaining fifth and sixth GCPs.
13. Close the sidebar by clicking the “X” to the right of Properties.

B. Reoptimizing

1. Under Process, click Reoptimize and then save your project. Click OK if a warning message
appears.

NOTE: Running Reoptimize will rerun the first step of the 3-step process, Step 1 - Initial Procesing if it has
already been run. If the operation to rerun the first step fails, make sure you do not have the previously
generated Quality Report open in Adobe.

2. You can now proceed to Part 3: Creating a Dense Point Cloud and Orthomosaic.
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	2. Uncheck Start Processing Now since we’ll explore our processing options before we start aligning the images.
	3. Click Finish to finalize the initial project setup.
	NOTE: Depending on what outputs your project requires and what imagery you are loading, you can opt for different templates. For producing Point Clouds, DSMs, 3D Meshes and Orthomosaics from aerial imagery, you will select either Standard or Rapid 3D ...


	D. Exploring the Main Viewer
	1. Red: Menu bar
	Here you can find five menu bar items: Project, Process, View, rayCloud and Help. Depending on which tab you select, you can open, save, and create new projects, define properties of images and ground control points (GCPs), change your output coordina...
	2. Orange: Toolbar
	Depending on the status of the project and which options have been selected, some buttons within the Toolbar may be grayed out. These tools are divided into six subcategories: Project, Process, View, Navigation, Clipping and Point Cloud Editing. From ...
	3. Yellow: Home Tab, View Toolbar
	Home takes you back to your Welcome View window where you can select to generate a new project, open an existing project or access community forums and tips.
	4. Light green: Map View Tab, View Toolbar
	Map View will display a 2D map version of your project with a satellite imagery background when images are geotagged.
	5. Dark green: rayCloud Tab, View Toolbar
	The rayCloud tab is where you can visualize different elements such as cameras, GCPs, dense point cloud output, classification of cloud points and a textured 3D mesh. Here, you can also georeference your project, improve accuracy, create orthoplanes a...
	6. Purple: Mosaic Editor Tab, View Toolbar
	When Mosaic Editor is selected, you can visualize the DSM, DTM and mosaic, as well as improve the visual aspect of the orthomosaic.
	7. Brown: processing Menu
	Under the Processing Menu, Processing Options generates a pop-up window where you can edit your parameters for each of the individual steps: Initial Processing, Point Cloud and mesh and DSM, Orthomosaic and Index.
	8. Black: Processing View
	The Current bar shows the processing status of each sub-step is displayed as a percentage, and the Total bar will show the processing status of all steps that have been selected as the number of completed steps. Before hitting the Start button to run ...


	Part 2: Image Alignment and Calibration
	NOTE: In this exercise, the images you use are already georeferenced, enabling you to immediately start processing. In the case where your images may not be georeferenced, refer to the Appendix to learn how to place initial Ground Control Points (GCPs...
	A. Image Alignment and Calibration
	1. If you cannot see the Processing menu at the bottom left of the screen, navigate to and click on the View tab in the main menu and then click Processing.
	2. In the Processing menu at the bottom left of the main window, confirm that Step 1 - Initial Procesing, Step 2 - Point Cloud and Mesh, and Step 3 - DSM, Orthomosaic, and Index are red. Ensure that Step 1 is checked, and uncheck Step 2 and Step 3, th...
	3. Review the generated Quality Report to ensure that your data passes the Quality Checks listed at the beginning of the document.This will automatically export as a PDF to your project folder and update each time you run a new step.
	NOTE: Your Quality Report will also offer insight into Calibration Details where you check if all cameras have calibrated correctly in addition to the overlap the images possess and the uncertainties between the initial GCP placements versus their com...

	4. If not already selected, select the rayCloud tab on the left hand side of the software interface and navigate around the cameras and ATP cloud in the main window. Left click and hold to pan around and zoom into the point cloud as you move your mous...
	5. Monitor the processing status bar at the bottom of the Pix4Dmapper interface. After it completes the Initial Processing, go ahead and save your project (Project, Save).


	Part 3: Creating a Dense Point Cloud and Orthomosaic
	A. Generating a Dense Point Cloud
	1. Click on Processing Options in the bottom left-hand corner of the main window. Under the Point Cloud and Mesh section, locate the Point Cloud tab at the top. Under the Point Cloud Classification section, check Classify Point Cloud.
	2. Click OK to close Processing Options.
	3. In the Processing menu at the bottom left of the screen, confirm that Step 1 - Initial Processing is green and that Step 2 - Point Cloud and Mesh, and Step 3 - DSM, Orthomosaic, and Index are red. Make sure you uncheck Step 1 so as to not overwrite...
	4. Close your generated report, then navigate to Layers on the left-hand side of the screen and uncheck Cameras and Tie Points.
	5. Under Layers, check Point Clouds and click OK in response to the warning message as shown below. Navigate around your dense point cloud.
	NOTE: To tilt view your dense point and mesh, hold shift as you left click on your mouse or trackpad and move in the direction you would like to view the generated products from. Use the scroll wheel to zoom in and out. Left click to move horizontally...

	6. Under Project, click Save.

	B. Generating an Orthomosaic
	1. In the Processing menu, ensure that Step 1 - Initial Processing is still unchecked, uncheck Step 2 - Point Cloud and Mesh and check Step 3 - DSM, Orthomosaic, and Index. Click Start.This may take several minutes to run.
	2. Note how the newly generated Quality Report resembles the previous one with additional information about your orthomosaic. Click Close.
	3. On the left-hand side panel, click on Mosaic Editor.
	4. In the main menu at the top of the software interface, click Mosaic Editor, then View followed by Show DSM to view your DSM and navigate around the output using the same methods to zoom, pan and tilt as described in Part 3.
	5. In the main toolbar, click on the Display Mosaic dropdown and select Mosaic (group 1) to view and explore the orthomosaic output.
	6. In the Mosaic Editing menu on the right-hand side, click the Export button to have the output saved to your project folder pathway (see following figure). If you encounter a warning message about exporting your orthomosaic, click OK.
	7. Under Project, click Save.
	NOTE: Sometimes distortions may occur in an orthomosaic due to errors in the surface model and features not fully visible in overlapping images, especially if there is a lot of tall vegetation. You may wish to generate new products using different set...



	Appendix A: Ground Control Points (GCPs)
	Adding GCPs
	A. Adding Ground Control Points
	1. Under Project in the main window, click GCP/MTP Manager.
	2. Click Import GCPs.
	3. For Coordinates Order, select X, Y, Z then Browse and locate the Excel spreadsheet with the GCP coordinates in the course downloads folder titled Ex1_TonyGrove_GCPs.txt. Click Open and OK.
	4. Click Basic Editor.
	NOTE: The basic editor is used before processing the imagery. To add GCPs after processing you should use the rayCloud editor, which you will do with the remaining three GCPs later in this exercise.
	GCPs can be manually created using reference imagery and a digital elevation model (DEM). However, keep in mind that your products will only be as accurate as the reference data. In this exercise, GCP coordinates are provided, but tools like ArcGIS Pr...

	5. Review the images shown at the beginning of this Appendix) to see the locations of each GCP.
	6. Click on the first GCP in the GCP/MTP Table.
	7. Mark the target on at least ten of the corresponding photographs DJI_; 0243.JPG, 0244.JPG, 0242.JPG, 0193.JPG, 0270.JPG, 0192.JPG, 0194.JPG, 0271.JPG, 0269.JPG, 0241.JPG, 0165.JPG, 0166.JPG, 0164.JPG, 0319.JPG, 0320.JPG and 0318.JPG. Do this by sor...
	NOTE: It is important to note that all images in this sample dataset are oriented with north being up, which makes it easier to place the GCPs. This won’t always be the case since some flight plans have the UAS rotate 180  at the end of each flight li...

	8. Do the same for the second and third marker.
	i. For the second marker, you will locate the GCP in ten of the following photographs DJI_; 346.JPG, 345.JPG, 347.JPG, 318.JPG, 317.JPG, 344.JPG, 319.JPG, 320.JPG, 272.JPG, 271.JPG, 273.JPG, 270.JPG and 269.JPG.
	ii. For the third marker, you can locate the GCP in any of the ten following photographs DJI_; 275.JPG, 274.JPG, 239.JPG, 238.JPG, 276.JPG, 273.JPG, 240.JPG, 315.JPG, 314.JPG, 316.JPG, 237.JPG, 272.JPG, 241.JPG, 313.JPG, 317.JPG, 197.JPG, 198.JPG, 196...
	NOTE: To zoom in on the thumbnail image to place a GCP, you can pinch zoom using your computer’s trackpad, use the scroll wheel on your mouse, or drag the pointer on the scale bar to the left with magnifying glasses. To pan around the image, you can e...


	9. Once the first three GCPs have been placed on their respective images, click OK.
	10. Under Project in the main window, click Save Project.


	Further Georeferencing and Reoptimizing
	A. Georeferencing with rayCloud
	1. Under the View tab in the main menu, ensure rayCloud and Show Sidebar are turned on.
	2. Under Layers on the left-hand side, click the drop-down bar next to Cameras, and do the same again for Display Properties.
	3. Under Display Properties, locate the line for Position Error and uncheck the box.
	4. Drag the edge of the sidebar, located on the right, towards the left of the screen so that it fills most of the window.
	5. In the Layers list on the left-hand side, click the drop-down bar next to Tie Points if it is not already expanded, and do the same again for GCPs/MTPs and again for Display Properties.
	6. Click on the fourth GCP listed. Collapse the Selection section in the sidebar to close the image details and drag the Image Size slider to increase image thumbnail sizes.
	NOTE: As in Part 2, you can place your cursor on each image and zoom in and out using your trackpad or mouse scroll wheel. To pan the image, left click and drag. If necessary, hold your cursor over an image and tap the spacebar for it to fill your scr...

	7. Review the images shown in the earlier section of this Appendix to find the target for the fourth GCP. Try to locate the GCP in image DJI_0121.JPG, displayed in the sidebar. Take note that by placing the first three GCPs and running the initial pro...
	8. Confirm the location of the same GCP in image, DJI_0122.JPG. The yellow circle that appears around the GCP confirms that it has been marked successfully.
	9. Click Selection to expand the GCP’s details and then click Apply. Collapse the Selection section once again. This will automatically place the GCP on the remaining images for you.
	10. Drag the Zoom Level slider to the right until you can see the target for the GCP clearly in the remaining images. Click on the green crosses to confirm the location of it in each additional image.
	11. Expand the Selection section once again and hit Apply. If more images appear, continue through the process of confirming the GCP location and clicking Apply until no more new images appear.
	12. Follow steps 6. through 12. for the remaining fifth and sixth GCPs.
	13. Close the sidebar by clicking the “X” to the right of Properties.

	B. Reoptimizing
	1. Under Process, click Reoptimize and then save your project. Click OK if a warning message appears.
	NOTE: Running Reoptimize will rerun the first step of the 3-step process, Step 1 - Initial Procesing if it has already been run. If the operation to rerun the first step fails, make sure you do not have the previously generated Quality Report open in ...

	2. You can now proceed to Part 3: Creating a Dense Point Cloud and Orthomosaic.





